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Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully 
complying with safety standards. To maintain this condition and to ensure safe operation, you must 
observe all instructions and warnings provided in this manual. If you have any questions regarding these 
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 
and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories. For product-specific 
information, see the data sheet and the product documentation. 

Safety labels on products 

The following safety labels are used on products to warn against risks and dangers. 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 
insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 
disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 
devices 

EU labeling for separate collection of electrical 
and electronic devices 

For additonal information, see section "Waste 
disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 
"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

Indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

Indicates information considered important, but not hazard-related, e.g. 
messages relating to property damage. 
In the product documentation, the word ATTENTION is used synonymously.  

 
These signal words are in accordance with the standard definition for civil applications in the European 
Economic Area. Definitions that deviate from the standard definition may also exist in other economic 
areas or military applications. It is therefore essential to make sure that the signal words described here 
are always used only in connection with the related product documentation and the related product. The 
use of signal words in connection with unrelated products or documentation can result in misinterpretation 
and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, use only 
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 
level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 
overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 
or connector strips are implemented, they must be checked on a regular basis to ensure that they are 
safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 
accessible at all times. For example, if the power plug is the disconnecting device, the length of the 
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 
disconnection from the AC supply network. If products without power switches are integrated into 
racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 
ensure that they are in proper operating condition. By taking appropriate safety measures and 
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 
fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 
taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 
on site and the product's protective conductor must be made first before any other connection is 
made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 
product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1). Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 
item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 
can cause biological harm due to the properties of their radiation and due to their extremely 
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 
product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22, 
EN 55032/CISPR 32) 
− Class A equipment:  

Equipment suitable for use in all environments except residential environments and environments 
that are directly connected to a low-voltage supply network that supplies residential buildings  
Note: Class A equipment is intended for use in an industrial environment. This equipment may 
cause radio disturbances in residential environments, due to possible conducted as well as 
radiated disturbances. In this case, the operator may be required to take appropriate measures to 
eliminate these disturbances. 

− Class B equipment: 
Equipment suitable for use in residential environments and environments that are directly 
connected to a low-voltage supply network that supplies residential buildings 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  
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2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, protective conductor test, 
insulation resistance measurement, leakage current measurement, functional test). This helps ensure 
the continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  



Instrucciones de seguridad elementales 

1171.0000.42 - 07 Page 7 

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 
point or via a Rohde & Schwarz customer service center. 

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 
must be collected separately. 
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 
take-back obligations and disposal obligations for manufacturers within the EU. Contact your 
Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 
¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. 
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá 
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas 
Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas 
informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 
documentación del producto. 

Señalización de seguridad de los productos 

Las siguientes señales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros. 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 
MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 
elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 
aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 
sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 
separado de dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 2. 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

Indica una situación de peligro que, si no se evita, causa lesiones 
graves o incluso la muerte. 

Indica una situación de peligro que, si no se evita, puede causar 
lesiones graves o incluso la muerte. 

Indica una situación de peligro que, si no se evita, puede causar 
lesiones leves o moderadas. 

Indica información que se considera importante, pero no en relación 
con situaciones de peligro; p. ej., avisos sobre posibles daños 
materiales.  
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 
±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 
eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 
causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 
interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 
conexión se deberá considerar como un dispositivo de desconexión.  
El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 
Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 
conexión no debe superar 3 m).  
Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 
integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 
nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 
alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 
reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 
causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 
clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 
las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 
En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogía con EN 
55022 / CISPR 22, EN 55032 / CISPR 32) 
− Aparato de clase A:  

Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos 
conectados directamente a una red de distribución de baja tensión que suministra corriente a 
edificios residenciales.  
Nota: Los aparatos de clase A están destinados al uso en entornos industriales. Estos aparatos 
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles 
perturbaciones guiadas o radiadas. En este caso, se le podrá solicitar al operador que tome  las 
medidas adecuadas para eliminar estas perturbaciones. 

− Aparato de clase B: 
Aparato adecuado para su uso en entornos residenciales, así como en aquellos conectados 
directamente a una red de distribución de baja tensión que suministra corriente a edificios 
residenciales. 
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Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  
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2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 
cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 
sino que deben ser recogidos por separado. 
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 
plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 
desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 
al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 
Rohde & Schwarz. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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List of abbreviations 
ADR  Automotive Dead Reckoning 

DR  Dead Reckoning 

PPS  Pulses per Second 
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1 Welcome to the R&S TSMX-PPS2 
The R&S TSMX-PPS2 is a small, compact GPS receiver with high sensitivity and 
precision time pulse output. It is based on a LEA 6 GPS chipset. The u-blox 
“Automotive Dead Reckoning” (ADR) feature provides 100 % positioning even in 
tunnels. 

It is especially designed for drive test systems based on R&S ROMES software in 
combination with R&S radio network analyzers where continuous position tracking and 
exact time synchronization of the utilized radio network analyzers is a requirement. 

1.1 System Requirements 

• PC with USB interface 

• Operating System: Microsoft Windows 7, Windows XP 

• USB driver / provided in the accessory CD-ROM 
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2 Device Tour 
This section gives an overview of the control elements and the connectors of the 
R&S TSMX-PPS2. Each element/connector is briefly described and a reference is 
given to the chapters containing detailed information.  

2.1 Top View - Status LEDs 

Figure 2-1: Top panel view 

 

1 "STATUS“ – LEDs  

1 STATE 

The STATE LED shows the power state of the 
device.  

● Green: device is powered from the USB port 

● Yellow: device is in STB state 

● Off: the device is un-powered 

2 PPS 

The PPS LED indicates the availability of the 
precision time pulse signal on the PPS OUT 
connector. It is also a quality indicator of the GPS 
position fix.  

● Green (blinking, 1 Hz): the GPS module is in 
tracking mode and PPS pulse is output on the 
PPS OUT connector 

● Off: GPS module is not in Tracking Mode 
resp. bad GPS health condition – no time 
pulse signal on the PPS OUT connector is 
available 
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2.2 Connectors - 1 

Figure 2-2: Front panel view 

 

1 SENSOR IN  

ODU MINI-SNAP connector, 6 pins 

Sensor interface for vehicle speed and direction 
signal (odometer). The supplied accessory sensor 
cable is used to bring these signals into the 
device. Sensor signals are only necessary if ADR 
should be supported.  

 

2 USB  

USB connector Type B 

The USB port serves as power supply and as bi-
directional data interface. Position data and 
device control data will be transferred via this 
interface.  

 

3 PPS OUT 
 

SMA connector (female) 

Output port for the precision time pulse signal.  

Source Impedance: 100 R 

Level: TTL / 3,3 V 
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2.3 Connectors - 2 

Figure 2-3: Rear panel view 

 

1 GPS ANT  

SMA connector (female) 

Bi-directional GPS antenna port. 

• Input: GPS antenna signal (GPS 
antenna is part of the accessory 
package) see section "Accessory List" 
on page 42. 

Impedance 50 Ω

Recommended GPS antenna characteristics  

Noise figure: < 3 dB 

Max antenna gain: 50 dB (minus cable 
and interconnect losses) 

Output: antenna bias voltage for active antennas. 
The antenna bias voltage is fed through the inner 
conductor. 

Output voltage: 3.3 V 

Max. Output Current: 50 mA 
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3 System Configurations 
3.1 Standard Navigation  

The R&S TSMX-PPS2 is used for GPS navigation in this configuration. The time 
synchronization output and the ADR feature are not used for this setup.  

The active GPS antenna is connected to the antenna port. Data connection and power 
supply are provided from the host PC via USB. 

The preferred host PC application is R&S ROMES. This software is not part of this 
package. For details about R&S ROMES software, please follow this link to the product 
homepage: http://www.rohde-schwarz.com/product/ROMES.html.

For test, evaluation and backup is the evaluation software “u-center” from u-blox 
included on the accompanying CD-ROM. But any other customer software capable of 
handling NMEA and/or the proprietary UBX protocol could be used to control the 
device and evaluate the GPS data. 

Figure 3-1: System Configuration - Standard Navigation 

http://www.rohde-schwarz.com/product/ROMES.html
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3.2 Time Synchronization  

The R&S TSMX-PPS2 is used as a precision time reference in this configuration. The 
precision time pulse signal (PPS OUT) from the device is used to synchronize the 
R&S TSMU Radio Network Scanner family (see section "Navigation & Time 
Synchronization" on page 11) but can also be used as a reference in customer specific 
device setups. 

In such a configuration the R&S TSMX-PPS2 is connected to the GPS antenna and 
calculates continuously the GPS position. The accessory sync cable is used to bring 
the trigger pulse from the PPS OUT port to the PULSE-IN connector of the R&S TSMU 
respectively to the trigger in signal of the OEM device. The device is powered and 
optionally controlled via USB. 

Running PC software for R&S TSMX-PPS2 control is not mandatory in this mode as 
far as the default settings are convenient for the application. As long as the 
R&S TSMX-PPS2 can determine a GPS fix the precise PPS signal will be available.  

Frequency, precision edge, pulse width and frequency could be altered and stored in 
the device using u-center software (see section "Time Pulse Settings" on page 34). 

Figure 3-2: System Configuration – Time Synchronization 
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3.3 Navigation & Time Synchronization  

The R&S TSMX-PPS2 is used for navigation and time synchronization in this 
configuration. 

The connections for this setup are shown in Figure 3-3.

This setup represents the basic mode of operation for the R&S TSMX-PPS2.  

The active GPS antenna is connected to the antenna input. The USB port is used for 
navigation data and device configuration. This port is controlled by R&S ROMES 
software.  

Figure 3-3: System Configuration – GPS Navigation & Time Synchronization  
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3.4 ADR Navigation  

The Automotive Dead Reckoning feature (ADR) of the R&S TSMX-PPS2 provides 
100 % navigation coverage even in tunnels or building canyons with bad or missing 
GPS coverage. ADR combines the calculated GPS position data with heading and 
distance data from additional sensors. When GPS satellites are out of sight, the last 
valid position is extrapolated using distance and angle information from a gyroscope 
and a speed/direction pulse input.  

It is also possible to use the time synchronization output in this mode. 

The gyroscope for heading information is already embedded in the R&S TSMX-PPS2. 
The distance signal and the direction information need to be derived from the vehicle 
tachometer pulses and direction indication and fed via the accessory sensor cable into 
the SENSOR IN port. Power supply and data connection are provided via the USB 
cable. 

Figure 3-4: TSMX-PPS2 Operating Mode – Automotive Dead Reckoning 
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4 Getting Started 
This section explains how to bring the R&S TSMX-PPS2 device into operation and 
shows the different mode of operations. It encloses connecting the device with the host 
PC.  

It does not contain installation of application software, e.g. R&S ROMES software. 
Please refer to the related software manuals. 

4.1 Unpacking and Checking 

To remove the device from its packaging and check the equipment for completeness, 
proceed as follows: 

• Remove the device and the various components from their packaging. 

• Check the equipment for completeness using the delivery note and the "Accessory 
List" for the various items. 

• Check the device for any damage. If there is damage, immediately contact the 
carrier who delivered the device. Make sure not to discard the box and packing 
material. 

Packing material 
Retain the original packing material. If the device needs to be transported or 
shipped at a later date, you can use the material to prevent control elements 
and connectors from being damaged. 
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4.2 Preparations 

The accessory re-closable Dual Lock Fastener®3M strip should be used for attaching 
the device. This strip has to be cut to fit along the bottom side of the housing as shown 
in Figure 4-1. The counterpart of the Dual Lock Fastener®3M should be cut to have 
similar length. 

Prior to applying 3MTM Dual Lock TM the bottom cover of the device should be cleaned 
with warm water and dishwashing liquid. A 50:50 mixture of isopropyl alcohol (IPA) and 
water may also be used.  

• To obtain optimum adhesion the bonding surface must be well unified, clean and 
dry. 

• Remove the backing plastic from the Dual Lock Fastener®3M without touching the 
adhesive strip. Align the tape to the desired position at the bottom side of the 
device and apply pressure to the tape. Firm application pressure develops better 
bond strength.  

• Turn the R&S TSMX-PPS with the Dual Lock Fastener®3M facing upwards. 

• Align the remaining strip and press both sides together unit you hear an audible 
snap but don’t remove the backing plastic. The unit is now ready to be placed in 
the vehicle according to the recommendations in the following section. 

Figure 4-1: Dual Lock Re-closable Fastener 
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4.3 Placing Hardware  

4.3.1 Placing the R&S TSMX-PPS2  

Standard Navigation (without ADR): No strict mounting recommendations. The 
device could be positioned anywhere and in any direction (horizontally or vertically) 
inside the vehicle or the trunk.  

ADR Navigation: Calculations for ADR are based on quite sensitive and three 
dimensional acceleration values. For that reason a strict horizontal mounting position 
(with printed, brighter chassis side up) which is fastened tightly with the vehicle chassis 
is absolutely important 

 

• Clean and dry the surface of the mounting position inside the vehicle in a similar 
way as done for bonding the Dual Lock Fastener®3M on the device. 

• Remove the protection plastics and press the R&S TSMX-PPS firmly against to 
proper mounting position. 

• Allow Dual Lock adhesive to cure for ten hours. 

4.3.2 Positioning the Antenna  

A magnetic mount antenna is part of the delivery. The antenna should be placed on a 
metallic part of the vehicle chassis with free line of sight to the sky. 

Without ADR: For optimum performance, the antenna should be placed in the middle 
of the vehicle roof or trunk. 

ADR Support: For an optimum ADR performance the placement of the antenna is 
important and depends on the type of vehicle. Please follow these recommendations: 

• Road Vehicle  

� Antenna: should be placed above the middle of the  
rear (not steered) wheels. 

� TSMx-PSS2: should be placed in the front or middle part of  
 the vehicle 

 

Consider Mounting Requirements for ADR Navigation 
Proper mounting position and tight connection with the vehicle chassis is 
absolutely necessary when operating the R&S TSMX-PPS2 in “Automotive 
Dead Reckoning” mode. 
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• Articulated Road Vehicle  

� Antenna: should be placed above the middle of the  
rear (not steered) wheels of the anterior part 
of the vehicle. 

� TSMx-PPS2: should be placed in the front or middle part of  
the anterior part of the vehicle. 

• Rail Vehicle  

� Antenna: should be placed in the middle of a wagon. 
� TSMx-PPS2: should be placed in the front or middle part of  
 the same wagon. 
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4.4 Installing Software / Device Driver 

Next step after having positioned the R&S TSMX-PPS2 inside the vehicle is to install 
the control software on the host PC side. 

This has to be done prior to first connecting the R&S TSMX-PPS2 with a PC. 
Depending on the target software used (ROMES, u-Center etc.) the Windows device 
driver for the u-blox LEA-6R chipset has to be installed in addition.  

Hint 
R&S TSMX-PPS2 requires u-blox device driver to be installed prior to first 
connection via USB cable. 

Please follow the guidelines in this section. 

4.4.1 R&S ROMES 

The R&S ROMES software is not part of the R&S TSMX-PPS2 delivery.  

Please refer to section "Rohde & Schwarz Internet Pages" on page 44 for a link to the 
related product homepage or contact your local R&S representative. 
 

For users with an existing ROMES installation: 

The u-blox device driver installation is not part of the integral ROMES setup and need 
to be executed separately from the R&S ROMES DVD.  

To get sure having installed the necessary Windows driver Rohde & Schwarz 
recommend to install the driver from the accompanying R&S TSMX-PPS2 CD-ROM 
(see next paragraph for instructions). 

For all other users: 

The device driver for Windows XP, Vista, 7, 8 can be found on the accompanying CD-
ROM in the folder: \Software\Drivers\ 

For installation run the executable file: ublox_A4_U5_USB_drvxxyy_install_UI.exe 

For release notes and to download of the latest device driver version also visit the u-
center website. Please refer to section "u-blox Internet Pages" on page 44 for the link. 

Hint 
The ROMES setup is not part of this package and needs to be installed 
separately. 
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4.4.2 u-center Evaluation 

The u-Center setup is part of the accessory CD-ROM: 

..\software\Applications\ 

The Windows device driver installation is part of the u-Center setup. So no dedicated 
device driver installation is necessary when using u-Center software. 

For a link to the u-center website for release notes and news refer to section "u-blox 
Internet Pages" on page 44. 

For instructions how to control the R&S TSMX-PPS2 via u-Center software, please 
refer to section "u-blox Internet Pages" on page 44. 

4.4.3 Microsoft Windows 7 USB Sensor/VCP Driver 

The windows 7 operating system provides built-in support for sensor devices including 
location sensors, such as the R&S TSMX-PPS2 devices. This driver model is currently 
not supported by R&S ROMES software but may be used for an OEM integration of 
this GPS receiver. 

For installation run the executable file: please refer to section "u-blox Internet Pages" 
on page 44. 

For a link to the u-blox senor driver please refer to section "u-blox Internet Pages" on 
page 44. 
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4.5 Connecting Cables 

4.5.1 GPS antenna / GPS ANT 

Connect the accessory active GPS antenna to the GPS ANT port.  

 

The R&S TSMX-PPS2 is designed for both active and passive antennas. This port 
provides an open circuit and short cut protection.  

Due to better navigation performance, R&S generally recommends to use active 
antennas, especially the antenna shipped with the product. 

For details on the accessory antenna characteristics, please refer to the u-blox 
datasheet for the ANN-MS antenna. Link to website in section "u-blox Internet Pages".

R&S recommends the following antenna characteristics for customers using their own 
antenna: 

• Frequency:  1575 ±3 MHz  

• Bandwidth:  min. 10 MHz 

• Polarization:  RHCP 

• Min Supply Voltage: ≥ 3.0 V 

• Max current:  50 mA 

• Impedance:  50 Ω

• Min Noise figure: 1.5 dB 

• min VSWR:  2 

• Min. Gain:  15 dB 

• Max. gain:   50 dB (minus cable and interconnect losses) 

Consider order of connection 
When connecting the external cables it is strongly recommended to proceed 
in the same order as listed in the following section.  

Interchanging the order could end in unexpected system behavior and in 
longer start times for a valid GPS position fix. 

Antenna connection only in un-powered mode 
Connect the GPS antenna before powering the device via USB.  
As the R&S TSMX-PPS2 calibrates the noise floor of the RF antenna at 
power on delayed connection may result in a prolonged GPS acquisition time.
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4.5.2 Sensor cable / SENSOR IN 

 

The sensor cable is part of the delivery. The plug has to be connected with the 
SENSOR IN port of the R&S TSMX-PPS2. The opposite side needs to be wired with 
the speed pulse and direction signal of the vehicle. 

The sensor input at the R&S TSMX-PPS2 is electrically isolated via optical coupler. 
Figure 4-2 Sensor Cable 

 

Lead Color Signal Description Pin 

Black SPEED+ 1 

Brown SPEED- 2 

Red DIR+ 3 

Orange DIR- 4 

- Device Detection / GND 5

- GND 6 

Figure 4-4 Pin out Sensor Cable 

Sensor Signals for ADR (Automotive Dead Reckoning) 
Connecting the sensor cable and providing the vehicle signals is mandatory 
for the ADR feature. 
Operating the R&S TSMX-PPS2 in standard navigation mode should leave 
this port unconnected. 

Figure 4-3 Frontal view on the pins of the Sensor 
Cable connector 



R&S TSMX-PPS2 Getting Started 

Getting Started 1515.7236.02 - 02 21 

4.5.2.1 Speed Pulse Signal  

This signal is mandatory for using the ADR function. The signal should fulfill the 
following recommendations: 

• signal level range for high level: 3.5 V < Level < 15 V 
• input frequency range: 0 Hz < Frequency < 2 kHz 
• 0 Hz of the speed signal must be equal to a speed of 0 km/h 
• speed signal should origin from the rear (not steered) wheel 

The speed signal is normally available in the radio slot of the vehicle. 

4.5.2.2 Direction Signal  

The direction signal is optional and only improves the results of the DR algorithm. As 
the forward/backward direction signal is not available in all vehicles, try to make use of 
the reverse gear light signal. 

• Valid Signal Level Range for high level: 3.5 V < Level < 15 V 
• Level > 3,5 V -> backward direction 

4.5.3 Sync Cable  

• The Sync Cable (SMA -> BNC) is part of the delivery (see "Accessory 
List"). 

The precision time pulse is available on the PPS port and used for synchronizing 
external measurement equipment with the GPS time. 

This port is normally connected to the trigger input of the R&S TSMU scanner (see 
Figure 3-2). If not used this port may be left open. 

The time delay for the time pulse strongly depends on the connected load capacity on 
the PPS port and this is application specific. For synchronizing R&S TSMU radio 
network scanners this does not harm as only the relative relationship of the pulses is 
important. 

Users with an absolute requirement for the pulse signal are able to configure a 
dedicated time shift using u-center software (see section "Time Pulse Settings"). 

Load capacity Typical delay (approximately) 

15 pF 0.6 – 3.7 ns 

30 pF or 50 pF 1 – 4.5 ns 

Table 4-1: Typical delay of the PPS OUT pulse 
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4.6 Powering On / Loading USB Driver 

The R&S TSMX-PPS2 has no dedicated On/Off Switch and automatically changes into 
“Power On” state when connected to the USB port. The green “STATE” LED is on 
when powered (see section "Top View - Status LEDs"). 

Windows will identify the R&S TSMX-PPS2 as a new device and load the pre-installed 
device driver. Please refer to section "Installing Software / Device Drive" how to install 
the USB driver. 

After enumeration “u-blox 6 GPS Receiver” device is listed in the Windows device 
manager (see Figure 4-5). Please notice the assigned COM port number. This 
information will be needed in the next step when connecting software to the 
R&S TSMX-PPS2 (see section "Connecting Device" on page 23). 

Figure 4-5: Device Entry in the Windows Device Manager 
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5 Starting Operation 
5.1 Connecting Device  

The R&S TSMX-PPS2 device is ready to be addressed via software as soon as the 
device driver is listed in the Windows device driver (see section "Installing Software / 
Device Driver" on page 17). 

The device could be connected to software using its assigned virtual COM port. For 
default protocols and settings of the emulated COM port refer to section "USB Port 
Settings" on page 38. Please refer to the related software documentation how to setup 
and perform measurements with the R&S TSMX-PPS2 device. 

R&S ROMES Software: see section "Rohde & Schwarz Internet Pages" 
for a product link 

u-center software: see section "Connecting R&S TSMX-PPS2" 
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5.2 Initial Position Fix  

The device automatically starts calculating for an initial GPS position fix. In GPS 
receivers one generally distinguishes between different start up modes. This depends 
on the available GPS information in the receiver at start up.  

The following table gives an overview: 

Start Up Mode Pre-Condition Remarks 
ADR 
Calibration 

TTFF1) 

[sec] 

Cold Start Un-powered for 
more than ~ 3 
hours 

- No information of satellite  
 position (almanac/ephemeredes)
- No sensor calibration data 

yes < 32 

Hot Start Disconnected 
from USB power 
< 3 hours 

- satellite ephemeredes available 
- sensor calibration data available 

no < 3 

Table 5-1: Modes of Position Fix in R&S TSMX-PPS2 

1) TTFF: Time to First Fix (good GPS signal) 

 

A valid GPS position fix with the transition into “Navigation State” is indicated by the 
amber PPS LED starting blinking (see section "Top View - Status LEDs" on page 6). 

 

The blinking frequency of the PPS LED is equivalent to the configured time pulse 
frequency setting (see section "Time Pulse Settings" on page 38). The precision time 
pulse is being output as soon as PPS LED starts blinking. 

 

ADR Navigation 
R&S strongly recommends not moving the vehicle until a valid 2D/3D position 
fix had been reported from the R&S TSMX-PPS2 when using ADR. 
Moving the vehicle earlier could last in inadequate sensor calibration and 
position localization errors. 

Proper Antenna Position 
The GPS antenna must have a good line of sight to the sky to enter 
“Navigation State” immediately. 



R&S TSMX-PPS2 Starting Operation 

Getting Started 1515.7236.02 - 02 25 

5.3 ADR Calibration  

5.3.1 General  

For optimum ADR performance the system needs to learn from the internal sensors 
(gyro & temperature) as well as from the provided vehicle signals (speed & direction). 

The calibration process is initiated at the beginning of each drive as long as no 
calibration data set is available from a previous drive (see Cold Start in section "Initial 
Position Fix"). The calibration data set is kept in the volatile part of the memory and this 
is provided with a battery backup that lasts for roughly about for three hours. So any 
time the R&S TSMX-PPS is disconnected from power and this time period is expired 
the device will re-calibrate. 

For the time the R&S TSMX-PPS2 executes sensor calibration it is in GPS-only mode 
and already provides navigation data. When calibration is finished to a certain degree it 
switches into combined mode and combines Dead Reckoning (DR) calculations and 
GPS and changes into “GPS + DR”.  

As the calibrations are based on real position data a good GPS reception is necessary. 

 

Attention 
This section is important for operating the R&S TSMX-PPS2 in ADR mode 
with connected vehicle sensor signals (see section "ADR Navigation" on 
page 12). 

Users running the R&S TSMX-PPS2 in standard navigation mode or time 
sync mode could skip this section and proceed to section "Navigation Mode" 
on page 29. 

Requirements for ADR calibration phase 
• ADR calibration process requires good GPS position fix 

• The calibration should only be executed when driving forwards 
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The following parameters are being measured when calibrating: 

• Sensitivity and zero point output of the internal Gyro 

• Temperature drift of the Gyro 

• Pulse ratio of the vehicle wheel ticks 

The course calibration of the gyro and the resolution of the vehicle wheel ticks need to 
be executed when doing sensor calibration. 
The fine calibration of the sensor signals is an ongoing process for the whole drive. 
For details please refer to the following sections and to the corresponding u-blox 
documentation for the LEA-6R chipset. To get a link, please refer to section "u-blox 
Internet Pages".

Validity of Calibration Data 

As the R&S TSMX-PPS2 is only equipped with a short time back-up buffer for this 
memory (backup time ~ 3 hours). 

For that reason the device will run a new calibration every time the USB power was 
disconnected for longer than this period. Calibration of the senor data will be kept. 

5.3.2 Providing Vehicle Sensors Data  

Even better the device knows to interpret the measurement data of the used sensors, 
the more precise and quicker is the calibration process. The sensitivity and offset of the 
embedded gyro is already programmed at factory for that purpose.  
To speed up ADR calibration and to achieve proper function the system needs to know 
the parameters of the external vehicle sensors.  

a) Polarity of the direction signal 

This setting is mandatory and important when the sensor cable is connected.  

Default setting: “1 – High=Backward”

Direction Signal Polarity 
ADR positioning will not work or is incorrect if the polarity setting is erroneous.

b) Resolution of the speed pulses 

Setting optional but could speed up calibration process. System is able to calculate 
resolution based on the driven GPS distance.  

How to enter senor data: 

ROMES: The sensor data is normally needed to be provided when loading 
R&S TSMX-PPS2 driver. Please refer to the related ROMES documentation. 

u-center: Please refer to section "Verifying ADR Settings" on page 33 how the enter. 



R&S TSMX-PPS2 Starting Operation 

Getting Started 1515.7236.02 - 02 27 

5.3.3 Monitoring Calibration Status  

The current state of the ADR calibration will be continuously reported from 
R&S ROMES software. Please refer to the R&S ROMES manual for details. 

For requesting the status of the ADR calibration, please refer to section "ADR 
Calibration Status" on page 36. 

There are different steps for calibration 

• No calibration 

• not yet calibrated  (Calibrating)

• coarsely calibrated  (Coarse Calib)

• finely calibrated  (Fine Calib)

Minimal calibration state for ADR 
A sufficient ADR performance can be expected when at least coarse 
calibration has been achieved. 

Fine calibration isn’t mandatory for ADR assistance.  

If the calibration status reaches “Fine Calibration” the user can expect very good 
ADR functionality and the device will use this feature to improve the accuracy 
respectively to bridge short times with poor or missing GPS reception.  

How to see if ADR works properly? 

ROMES: the ADR state will be reported in the GPS status view (see R&S ROMES 
documentation for details). 

u-Center: whether ADR is used is displayed in the “Data View” of the u-center 
software 

Figure 5-1: GPS status overview 

 

If calibration does not start measurement see troubleshooting section "ADR Calibration 
fails" on page 41. 
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5.3.4 Deleting Calibration Data  

A delete of the sensor calibration data is necessary under the following circumstances: 

• when changing the measurement vehicle 

• when exchanging vehicle sensors 

• when the GPS provides insufficient localization data especially after tunnels or 
in situations with bad GPS coverage 

R&S ROMES software will offer a dedicated action menu in the R&S TSMX-PPS2 
software driver for deleting this data. Please refer to the R&S ROMES documentation 
how to initiate this. 

For u-center software please refer to section "Resetting Sensor Calibration" on 
page 34. 
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5.4 Navigation Mode 

The GPS module automatically enters navigation mode as soon as it determined the 
GPS position fix. Depending of the mode of operation (ADR or Standard Navigation) 
the GPS will be assisted from dead reckoning data when calibration is finished (see 
section "Monitoring Calibration Status" on page 27). 

Following a list of the different navigation modes: 

Navigation Mode Remarks 

No Fix No position fix 

2D Fix Two-dimensional fix / at least 3 satellites 

3D Fix Three-dimensional fix / at least 4 satellites 

DR Dead Reckoning 

DGPS Differential GNSS 

Figure 5-2: Modes of navigation 

5.5 Powering Off 

There is no dedicated switch to power off the R&S TSMX-PPS2. The device is turned 
off by removing the USB cable. The GPS almanac data and sensor calibration data is 
kept for a certain amount of time when disconnected from USB. 

 

There is no “Stand-By” or “Power Safe” mode implemented for the R&S TSMX-PPS2. 

Caution: 
Make sure that you have disconnected from any software application 
interfacing the R&S TSMX-PPS2 device before removing the USB cable.  
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6 Using u-center Software 
The u-center software is part of the delivery. Please refer to section 
“..\software\Applications\” on the accompanying CD-ROM for the setup und the user 
guide or visit the u-blox website (see section "u-blox Internet Pages" on page 44). 

This software can be used for test, evaluation and maintenance of the R&S TSMX-
PPS2. 

 
This free of charge demo software from u-blox gives the user the possibility to evaluate 
the various features of this GPS receiver. Additionally, it gives the user the possibility 
to change and store receiver settings permanently. 

For this software is used to bring the R&S TSMX-PPS2 back into factory default 
configuration. For a detailed description how to restore factory setting (see section 
"Recover GPS Factory Settings" on page 37). 

Using R&S ROMES Software 
Generally, there is no requirement to use u-center software for device 
configuration when using R&S ROMES software. The R&S TSMX-PPS2 will 
be fully supported and configured via R&S ROMES software. 

Attention 
Using u-Center software enables the user to change receiver settings 
permanently. 
This may lead to un-predictable behavior and incompatibilities with 
R&S ROMES software. Under such conditions the R&S TSMX-PPS2 may be 
brought back to factory settings unless it may be used with R&S software 
again 
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6.1 Setting Preferences  

Some preferences of u-center software need to be adapted in order to get full access 
und functionality of the ADR configuration and replay control of exported R&S TSMX-
PPS2 data. For this reason, please open the preferences in the tools menu and enter 
the settings in the following subsections. 

 

6.1.1 Program Options 

In order to get full ADR access: 
 
Program Options: -sfdr –cdk 
 

Figure 6-1: u-center preferences 

6.1.2 Database 

If u-center software is used to export stored data to Google Earth the maximum 
number of epochs should be set to a sufficient time value (see Figure 6-1). 

If this time value is too small, the export of position data to Google Earth is limited in 
time and may not display all data.  

This value could be changed when data recording is stopped but before export of data. 

u-center: 
 → Tools → Preferences →Program Options: -sfdr –cdk 
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6.2 Connecting R&S TSMX-PPS2 

If the R&S TSMX-PPS2 is powered and the device driver loaded in Windows (see 
section "Powering On / Loading USB Driver" on page 22) it could be connected in u-
center software by selecting the emulated COM port. 

Figure 6-2: Connect to the R&S TSMX-PPS2 in u-center 

6.3 Configuration View 

The “Configuration Message View” could be used to change the configuration for the 
R&S TSMX-PPS2.  

u-center: 
 → Select menu “View” → Configuration View → Displays the list of 
configuration messages… 

Select the UBX message of interest in this view and press the button to retrieve 
the current configuration. 

For changing any setting select the corresponding UBX message and adapt the 
parameters in the message window. The new parameters will be sent to the receiver 
when pressing the button. 

The following sections list some of the important configuration commands for 
R&S TSMX-PPS2. 

Close other software applications when using u-center 
The R&S TSMX-PPS2 software interface does not allows any other software 
application to interface the device at the same time. 
So, be sure having closed possible connections in R&S ROMES software or 
any other software application when connecting to u-center. 
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6.3.1 Verifying ADR Settings  

Select “EKF” message in “Configuration View” 

u-center: 
 → Select menu “View” → Configuration View → EKF Settings 

1) Gyro 
Keep the default setting (see section "ADR Sensor Settings" on page 39). 

2) Temperature 
Keep the default setting (see section "ADR Sensor Settings" on page 39). 

3) Pulses 
The pulse ratio of the connected wheel sensor could be entered here. But this 
value will be calculated during calibration. 
 

4) Direction Pulse  
Change the polarity of direction signal if necessary. 

Figure 6-3: UBX Configuration Message “EKF”- Sensor Settings 

 
For changing any parameter select the corresponding “Set” tick to enter the new value. 
The new parameters will be sent to the receiver when pressing the button. 

To keep settings after re-powering the device, it is necessary to safe the configuration 
in the flash (see section "Saving User Configurations" on page 36). 
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6.3.2 Resetting Sensor Calibration 

Select “EKF” message in the “Configuration View” 

u-center: 
 → Select menu “View” → Configuration View → EFK → Tick at “Clear 
Calibration Data” → Click on “Send” in the left lower corner 

Figure 6-4: UBX Configuration Message “EKF”- Reset Sensor Settings 

6.3.3 Time Pulse Settings 

Select “TP” message in the “Configuration View” 

u-center: 
 → Select menu “View” → Configuration View → TP (Timepulse) 

Configurable parameters: 
 
Pulse Mode: defining edge for precision (rising or falling)  
Pulse Period: output frequency of time pulse  
Pulse Length: pulse length of the time pulse 
Time Source: reference for the time pulse (GPS time, UTC, etc.) 
 
For default settings please refer to section "Time Pulse Settings".

Figure 6-5: UBX Configuration Message “TP”- Time Pulse Settings 

To keep settings after re-powering the device, it is necessary to safe the configuration 
in the flash (see section "Saving User Configurations" on page 36). 
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6.4 Message View 

The “Message View” could be used to request certain status messages of the 
R&S TSMX-PPS2.  

u-center: 
 → Select menu “View” → Message View → Open “UBX” on the left tree 
view→Displays the list of available messages… 

Select the UBX message of interest in this view and press the button to request 
the specific information. 

The following sections list some of the important messages for the R&S TSMX-PPS2. 

6.4.1 Sensor Measurement Data 

Select “ESF-MEAS” message in the “Configuration View”  

u-center: 
 → Select menu “View” → Configuration View → ESF (External Sensor 
Fusion) → MEAS (Measurement data) 

This message visualizes the measurement data for the various sensors and gives an 
impression of sensor signals are being detected.  
 
Single Tick: Accumulated pulses of the wheel trigger 
Gyro Z: Acceleration in z-axis 
Gyro Temperature: Measurement of the internal temperature sensor 

Figure 6-6: UBX Message "NAV EKFSTATUS"- Status 
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6.4.2 ADR Calibration Status  

Select “ESF-STATUS” message in the “Configuration View”  

u-center: 
 → Select menu “View” → Configuration View → ESF (External Sensor 
Fusion) → STATUS (ESF status)  

This message gives a quick overview of the calibration state for the different sensors 
(temperature, wheel tick and gyro) and the usage of the different sensors for ADR.  
 

Figure 6-7 UBX Message “ESF-STATUS"- External Sensor Fusion 

For details about the various parameters of the please refer to the UBX Protocol 
Receiver Description → ESF-STATUS (see section "u-blox Internet Pages" on page 44 
for a link). 

This documentation is also included on the accessory CD-ROM 
(..\documents\Manuals\ u-blox6_ReceiverDescriptionProtocolSpec.pdf)

6.5 Saving User Configurations 

The u-center software can be used to store user defined device settings in a file. This 
file can be used later to configure other devices. 

u-center: 
 → Tools → GPS Configuration… 
→ click on GPS >> FILE 
→ select file and destination to store configuration and press Save 
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6.6 Recover GPS Factory Settings  

Under certain circumstances it is necessary to bring the R&S TSMX-PPS2 device back 
to factory setting. This could be done using the “GPS configuration” tool from u-center 
software. 

The factory configuration of the R&S TSMX-PPS2 is part of the CD-ROM. 

 
..\software\Default Configuration\TSMX-PPS2_DefaultConfig.txt 
 
For restoring the original device configuration, proceed as follows: 

u-center: 
 → Tools → GPS Configuration… 
→ select configuration file 
→ set tick to store configuration file into BBR/Flash 
→ click on File >> GPS 

Figure 6-8: GPS configuration window to reload and store GPS settings 
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7 Default Settings 
The R&S TSMX-PPS2 is being shipped with a factory configuration and is ready to 
use. By means of the u-center demo application or by any customer application, it is 
possible that these default settings are being re-configured in a way that the GPS 
receiver won’t work properly anymore. 

In order to overcome this, the device factory settings are part of the accessory CD-
ROM. This could be reloaded into the device by means of the u-center application (see 
section "Recover GPS Factory Settings" on page 37). 

7.1 USB Port Settings 

Regarding the USB interface specifications the receiver default settings are:  

• Interface:   USB 

• Protocols in:  UBX + NMEA + RTCM 

• Protocols out:  UBX + NMEA  

• Baud rate COM Port:  9600 

7.2 Time Pulse Settings 

• Precision of Signal: at 99 % of time < 60 ns; RMS = 30 ns  
(Under good GPS signal conditions) 

• Precision Edge (Mode):  rising / falling / disabled (default: Rising Edge) 

• Pulse Period/Freq.: adjustable 0.25 Hz to 1 kHz (default: 1 Hz) 

• Pulse Length:  adjustable; > 100 ns (default 100 ms) 

• Time Source:   UTC time / GPS time / Local time (default GPS time) 

• Cable Delay:  adjustable; default: 50 ns 

• User Delay:  adjustable; default: 0 ns  
(Positive delay results in earlier pulse) 

For details about possible configurations of the time pulse please refer to the UBX 
Protocol Receiver Description → Time pulse (see section "u-blox Internet Pages" on 
page 44 for a link). 

This documentation is also included on the accessory CD-ROM 
(..\documents\Manuals\ u-blox6_ReceiverDescriptionProtocolSpec.pdf)
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7.3 Protocol Settings  

The listed protocols are per default updated and transmitted: 

NMEA 

• GPGGA   (Global Positioning System Fix Data) 
• GPGLL   (Geographic Position – Latitude/Longitude) 
• GPGSA   (GNSS DOP and Active Satellites) 
• GPGSV   (GNSS Satellites in View) 
• GPRMC  (Recommended Minimum Specific GNSS Data) 
• GPVTG   (Course Over Ground and Ground Speed) 

UBX 

• ESF\MEAS  (Sensor Measurement Data) 
• ESF\STATUS  (Sensor Status) 
• NAV\EKFSTATUS (Dead Reckoning Overview) 

7.4 ADR Sensor Settings  

The following parameters are programmed from R&S ROMES software any time the 
R&S TSMX-PPS2 device is loaded as hardware device. R&S ROMES uses the EKF 
message of the UBX protocol. 

Sensor Calibration 

• Nom. Zero-Point Output: 2.500 [V] 

• Nominal Sensitivity:  25 [mV/(deg/s)] 

Temperature Calibration 

• Save-To-Flash Interval:  180 [s]   

• Gyro RMS:   1.0 [mV]  

Hardware Interface 

• Gyro Axis: V > 2.5 V =   1 – counter clock  

• Direction Pin Polarity:  1 – High = Backwards 

Direction Pin Polarity Interpretation of input level in the device 

0 High = Forward, Low = Backward 

1 (default) High = Backward, Low = Forward 

Table 7-1: Interpretation of direction signal 
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8 Troubleshooting  
8.1 Device does not power on  

The device has not changed into “Power On” state (STATE LED doesn’t lit green) after 
being connected to the host PC: 

1. Check USB cable connection  

2. Check if USB port is working well on the PC/Laptop/Tablet 

3. Nothing helps → contact your local R&S service 

8.2 Device not selectable in software 

The virtual COM for the R&S TSMX-PPS2 (u-blox 6 GPS Receiver) might not being 
listed in the Windows Device Manager. 

1. Check if the USB device driver had been installed correctly. Depending on the 
type of software application this has to be executed as a separate step: 

a. u-center: no special measures are necessary for device driver 
installation. This is integral part of the u-center setup. 

b. R&S ROMES: device driver for u-blox LEA-6R module need to be 
installed separately previous to starting software application. The 
device driver is included in the CD-ROM (..\software\Drivers\ 
ublox_USB_driver.exe). 

c. OEM application: the software originator is responsible for adding this 
into the dedicated setup 

2. Check the device driver version. 

If necessary, install the latest driver version for LEA-6 chipsets from the u-blox 
homepage. Please refer to section "u-blox Internet Pages" on page 44 for a link). 

8.3 No GPS position fix 

1. Check if GPS antenna is connected correctly. 

2. Check if GPS antenna has free line of sight to the sky. 

3. Signal is too poor or no signal → change to location with brighter sky view.  

4. Check the GPS receiver configuration. If necessary reset to factory settings. 
(see section "Recover GPS Factory Settings" on page 37). 

5. For ADR users: Reset sensor calibration and restart calibration (see section 
"Deleting Calibration Data" on page 28). 
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8.4 No Time Pulse (PPS) 

1. Check your PPS cable connections 

2. Check the position fix mode of your device. It has to be at least “2D” or “3D” 
position. In this case the PPS LED has to blink.  

a) If displayed “No Fix”, change your location to a place with brighter and 
better sky view. 

b) If Fix Mode is “2D” or even “3D” and PPS LED is blinking and no PPS 
signal can be detected on the output, please send the device to your 
local R&S service. 

8.5 ADR Calibration fails  

1. Check with u-center software whether the external sensor signals (speed and 
direction) and the embedded gyroscope are being detected (see section 
"Sensor Measurement Data" on page 35). 

• If speed signal is missing check whether the Sensor Cable is plugged in 
and connected correctly to the vehicle signals (speed & direction). Maybe 
check the outputted signal with an oscilloscope. 

• If the gyroscope signal is missing please send the device to our support, 
because greater damage could be happened to the device 

• If all signals are displayed go on with next step  

2. Try to restart the calibration by clearing the latest calibration data to get sure 
not to have any corrupted calibration data set (see section "Resetting Sensor 
Calibration" on page 34). 

3. Execute sensor calibration and monitor calibration status (see section "ADR 
Calibration Status" on page 36). If it still fails, please proceed with next step. 

4. Restore factory settings and repeat with step 3. If nothing helps please contact 
the local R&S service. 
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8.6 Checking extern sensor signals 

1. Check with u-center software whether the external sensor signals (speed and 
direction) and the embedded gyroscope are being detected (see section 
"Sensor Measurement Data" on page 35). 

• If speed signal is missing check whether the Sensor Cable is plugged in 
and connected correctly to the vehicle signals (speed & direction). Maybe 
check the outputted signal with an oscilloscope. If the Sensor Cable is 
firmly fixed to the car and measuring of the signals is only possible on the 
Sensor Cable connector (the pin out could be find in section “Sensor cable 
/ SENSOR IN” on page 20). 

Measuring direction: Changing from forward to reverse gear has to be 
combined with a change of the signal level (for example as a rule from 0 V 
to 12 V, sometimes also reverse) between the DIRECTION+ and the 
DIRECTION- pins. 

Measuring speed: When moving the vehicle, there should be a 
continuous square-wave, sinus- or a triangle-shaped signal (differs from 
car to car) with a frequency proportional to the driven speed between the 
SPEED+ and the SPEED- pins. 

• If the gyroscope signal is missing please send the device to our support, 
because greater damage could be happened to the device. 

• If all signals are displayed go on with next step. 

2. Check position of installation.  

• The device has to be firmly fixed horizontal with the printed, brighter 
chassis side up to the car chassis in a way that the device  could not move 
or turn (see section “Placing the R&S TSMX-PPS2” on page 15).  

• If the placement of the device is correct proceed with the next step. 

3. Restore factory settings to exclude faulty settings (see section “Recover GPS 
Factory Settings” on page 37). In this regard consider that the configuration is 
stored into BBR/Flash (→ set corresponding tick in the u-blox GPS 
Configuration window!).  

4. Check with u-center software whether the external sensor signals could now 
be detected.  

• If the signals are available proceed with sensor calibration (see section 
"ADR Calibration Status" on page 36) 

• If the signals are still not present please contact the local R&S service. 
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9 Accessory List  
• Cable USB/A-USB/B 1.3 m    0041.9177.00 

• Active GPS Antenna 5 m   1503.3624.00 

• Cable Sensor 1.5 m     1515.7213.00 

• CD with manual, software and drivers  1515.7165.08 

• Printed Getting Started Documentation  1515.7236.02 

• Cable Sync (SMA/BNC)    3522.0565.00 



R&S TSMX-PPS2 References & Links 

Getting Started 1515.7236.02 - 02 44 

10 References & Links  
All links listed in this document represent the state of release date and may be 
changed from u-blox without notice! 

10.1 Rohde & Schwarz Internet Pages 

Rohde & Schwarz Homepage 
http://www.rohde-schwarz.com

R&S TSMX-PPS2 Product Page 
http://www.rohde-schwarz.com/product/TSMXPPS2.html

R&S ROMES Software Product Page 
http://www.rohde-schwarz.com/product/ROMES.html

10.2 u-blox Internet Pages 

u-blox Homepage 
http://www.u-blox.com/index.php

LEA-6R Product Page 
http://www.u-blox.com/en/gps-modules/u-blox-6-dead-reckoning-module/lea-6r.html

u-blox Gen 6 Resources Overview 
http://www.u-blox.com/en/download/documents-a-resources/u-blox-6-gps-modules-
resources.html

UBX Protocol Description 
http://www.u-blox.com/images/downloads/Product_Docs/u-
blox6_ReceiverDescriptionProtocolSpec_%28GPS.G6-SW-10018%29.pdf

LEA-6R chipset 
http://www.ublox.com/en/gps-modules/u-blox-6-dead-reckoning-module/lea-6r.html

u-center Online Manual 
http://www.u-blox.com/images/downloads/Product_Docs/u-
Center_User_Guide%28GPS-SW-08007%29.pdf

u-center Program Download 
http://www.u-blox.com/en/evaluation-tools-a-software/u-center/u-center.html

Standard UBS driver 
http://www.u-blox.com/en/drivers-a-middleware/usb-drivers/windows-vistaxp2000-
driver.html

Windows sensor API driver 
http://www.u-blox.com/en/drivers-a-middleware/usb-drivers/windows-7-driver.html

http://www.u-blox.com/en/drivers-a-middleware/usb-drivers/windows-7-driver.html
http://www.u-blox.com/en/drivers-a-middleware/usb-drivers/windows-vistaxp2000-driver.html
http://www.u-blox.com/en/drivers-a-middleware/usb-drivers/windows-vistaxp2000-driver.html
http://www.u-blox.com/en/evaluation-tools-a-software/u-center/u-center.html
http://www.u-blox.com/images/downloads/Product_Docs/u-Center_User_Guide%28GPS-SW-08007%29.pdf
http://www.u-blox.com/images/downloads/Product_Docs/u-Center_User_Guide%28GPS-SW-08007%29.pdf
http://www.ublox.com/en/gps-modules/u-blox-6-dead-reckoning-module/lea-6r.html
http://www.u-blox.com/images/downloads/Product_Docs/u-blox6_ReceiverDescriptionProtocolSpec_%28GPS.G6-SW-10018%29.pdf
http://www.u-blox.com/images/downloads/Product_Docs/u-blox6_ReceiverDescriptionProtocolSpec_%28GPS.G6-SW-10018%29.pdf
http://www.u-blox.com/en/download/documents-a-resources/u-blox-6-gps-modules-resources.html
http://www.u-blox.com/en/download/documents-a-resources/u-blox-6-gps-modules-resources.html
http://www.u-blox.com/en/gps-modules/u-blox-6-dead-reckoning-module/lea-6r.html
http://www.u-blox.com/index.php
http://www.rohde-schwarz.com/product/ROMES.html
http://www.rohde-schwarz.com/product/TSMXPPS2.html
http://www.rohde-schwarz.com/
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